
ProMark™3 / ProMark3 RTK

Getting Started Guide

 



E
n
g
lish
Copyright Notice

Copyright 2005-2007 Magellan Navigation, Inc. All 
rights reserved.

Trademarks

All product and brand names mentioned in this pub-
lication are trademarks of their respective holders.

FCC Notice

This equipment has been tested and found to comply 
with the limits for a class B digital device, pursuant 
to part 15 of the FCC Rules. These limits are de-
signed to provide reasonable protection against 
harmful interference in a residential installation. 
This equipment generates, uses and can radiate ra-
dio frequency energy and if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications. However, 
there is no guarantee that interference will not occur 
in a particular installation. If this equipment does 
cause harmful interference to radio or television re-
ception, which can be determined by turning the 
equipment off and on, the user is encouraged to try 
to correct the interference by one or more of the fol-
lowing measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment 

and receiver.
• Connect the equipment into an outlet on a cir-

cuit different from that to which the receiver is 
connected.

• Consult the dealer or an experienced radio/TV 
technician for help.

Changes or modifications not expressly approved by 
Magellan Navigation could void the user's authority 
to operate this equipment.
CAUTION: To comply with FCC RF exposure compli-
ance requirements, a separation distance of at least 
20 cm must be maintained between the antenna of 
this device and all persons.

In the presence of RF field, the receiver's 
satellite signal strength may degrade. 
When removed from the RF field, the sig-
nal strength should return to normal.

RSS-210

This device has been found compliant with the Cana-
dian RSS-210 specification, issue 5, November 
2001 which stipulates that operation is subject to 
the following two conditions: (1) this device may not 
cause interference, and (2) this device must accept 
any interference, including interference that may 
cause undesired operation of the device.

Where to Find Information

This manual is designed to guide you through the ba-
sic ProMark3 procedures. You can find additional in-
formation in the ProMark3 RTK / ProMark3 
Reference Manual, also provided on the ProMark3 
CD.

-----------

Magellan Professional Products - Limited Warranty 

(North, Central and South America)

Magellan Navigation warrants their GPS receivers 
and hardware accessories to be free of defects in ma-
terial and workmanship and will conform to our pub-
lished specifications for the product for a period of 
one year from the date of original purchase. THIS 
WARRANTY APPLIES ONLY TO THE ORIGINAL 
PURCHASER OF THIS PRODUCT. 

In the event of a defect, Magellan Navigation will, at 
its option, repair or replace the hardware product 
with no charge to the purchaser for parts or labor. The 
repaired or replaced product will be warranted for 90 
days from the date of return shipment, or for the bal-
ance of the original warranty, whichever is longer. 
Magellan Navigation warrants that software products 
or software included in hardware products will be 
free from defects in the media for a period of 30 days 
from the date of shipment and will substantially con-
form to the then-current user documentation provid-
ed with the software (including updates thereto). 
Magellan Navigation's sole obligation shall be the 
correction or replacement of the media or the soft-
ware so that it will substantially conform to the then- 
current user documentation. Magellan Navigation 
does not warrant the software will meet purchaser's 
requirements or that its operation will be uninterrupt-
ed, error-free or virus-free. Purchaser assumes the 
entire risk of using the software.

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS 
WRITTEN WARRANTY OR ANY IMPLIED WARRAN-
TY SHALL BE LIMITED TO THE REPAIR OR RE-
PLACEMENT, AT MAGELLAN NAVIGATION'S 
OPTION, OF ANY DEFECTIVE PART OF THE RE-
CEIVER OR ACCESSORIES WHICH ARE COVERED 
BY THIS WARRANTY. REPAIRS UNDER THIS WAR-
RANTY SHALL ONLY BE MADE AT AN AUTHORIZED 
MAGELLAN NAVIGATION SERVICE CENTER. ANY 
REPAIRS BY A SERVICE CENTER NOT AUTHO-
RIZED BY MAGELLAN NAVIGATION WILL VOID 
THIS WARRANTY.

To obtain warranty service the purchaser must obtain 
a Return Materials Authorization (RMA) number prior 
to shipping by calling 1-800-229-2400 (press op-
tion #1) (U.S.) or 1-408-615-3981 (International), 
or by submitting a repair request on-line at: 
http://professional.magellangps.com/en/support/
rma.asp. The purchaser must return the product 
postpaid with a copy of the original sales receipt to 
the address provided by Magellan Navigation with 
the RMA number. Purchaser’s return address and the 
RMA number must be clearly printed on the outside 
of the package.

Magellan Navigation reserves the right to refuse to 
provide service free-of-charge if the sales receipt is 
not provided or if the information contained in it is 
incomplete or illegible or if the serial number is al-
tered or removed. Magellan Navigation will not be re-
sponsible for any losses or damage to the product 
incurred while the product is in transit or is being 
shipped for repair. Insurance is recommended. Ma-
gellan Navigation suggests using a trackable ship-
ping method such as UPS or FedEx when returning a 
product for service.

EXCEPT AS SET FORTH IN THIS LIMITED WAR-
RANTY, ALL OTHER EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING THOSE OF FITNESS 
FOR ANY PARTICULAR PURPOSE, MERCHANT-
ABILITY OR NON-INFRINGEMENT, ARE HEREBY 
DISCLAIMED AND IF APPLICABLE, IMPLIED WAR-
RANTIES UNDER ARTICLE 35 OF THE UNITED NA-
TIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS. Some national, 
state, or local laws do not allow limitations on im-
plied warranty or how long an implied warranty lasts, 
so the above limitation may not apply to you.

The following are excluded from the warranty cover-
age: (1) periodic maintenance and repair or replace-
ment of parts due to normal wear and tear; (2) 
batteries and finishes; (3) installations or defects re-
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sulting from installation; (4) any damage caused by 
(i) shipping, misuse, abuse, negligence, tampering, 
or improper use; (ii) disasters such as fire, flood, 
wind, and lightning; (iii) unauthorized attachments 
or modification; (5) service performed or attempted 
by anyone other than an authorized Magellan Naviga-
tions Service Center; (6) any product, components or 
parts not manufactured by Magellan Navigation; (7) 
that the receiver will be free from any claim for in-
fringement of any patent, trademark, copyright or 
other proprietary right, including trade secrets; and 
(8) any damage due to accident, resulting from inac-
curate satellite transmissions. Inaccurate transmis-
sions can occur due to changes in the position, 
health or geometry of a satellite or modifications to 
the receiver that may be required due to any change 
in the GPS. (Note: Magellan Navigation GPS receiv-
ers use GPS or GPS+GLONASS to obtain position, 
velocity and time information. GPS is operated by the 
U.S. Government and GLONASS is the Global Navi-
gation Satellite System of the Russian Federation, 
which are solely responsible for the accuracy and 
maintenance of their systems. Certain conditions can 
cause inaccuracies which could require modifica-
tions to the receiver. Examples of such conditions in-
clude but are not limited to changes in the GPS or 
GLONASS transmission.)  Opening, dismantling or 
repairing of this product by anyone other than an au-
thorized Magellan Navigation Service Center will void 
this warranty.

MAGELLAN NAVIGATION SHALL NOT BE LIABLE 
TO PURCHASER OR ANY OTHER PERSON FOR ANY 
INCIDENTAL OR CONSEQUENTIAL DAMAGES 
WHATSOEVER, INCLUDING BUT NOT LIMITED TO 
LOST PROFITS, DAMAGES RESULTING FROM DE-
LAY OR LOSS OF USE, LOSS OF OR DAMAGES 
ARISING OUT OF BREACH OF THIS WARRANTY OR 
ANY IMPLIED WARRANTY EVEN THOUGH CAUSED 
BY NEGLIGENCE OR OTHER FAULT OFMAGELLAN 
NAVIGATION OR NEGLIGENT USAGE OF THE 
PRODUCT. IN NO EVENT WILL MAGELLAN NAVI-
GATION BE RESPONSIBLE FOR SUCH DAMAGES, 
EVEN IF MAGELLAN NAVIGATION HAS BEEN AD-
VISED OF THE POSSIBILITY OF SUCH DAMAGES.

This written warranty is the complete, final and ex-
clusive agreement between Magellan Navigation and 
the purchaser with respect to the quality of perfor-
mance of the goods and any and all warranties and 
representations. This warranty sets forth all of Magel-
lan Navigation's responsibilities regarding this prod-
uct. This limited warranty is governed by the laws of 
the State of California, without reference to its con-
flict of law provisions or the U.N. Convention on Con-
tracts for the International Sale of Goods, and shall 
benefit Magellan Navigation, its successors and as-
signs.

This warranty gives the purchaser specific rights. The 
purchaser may have other rights which vary from lo-
cality to locality (including Directive 1999/44/EC in 
the EC Member States) and certain limitations con-
tained in this warranty, including the exclusion or 
limitation of incidental or consequential damages 
may not apply. 

For further information concerning this limited war-
ranty, please call or write:

Magellan Navigation, Inc., 960 Overland Court, San 
Dimas, CA 91773, Phone: +1 909-394-5000, Fax: 
+1 909-394-7050 or

Magellan Navigation SAS - ZAC La Fleuriaye - BP 
433 - 44474 Carquefou Cedex - France  Phone: +33 
(0)2 28 09 38 00, Fax: +33 (0)2 28 09 39 39.

Magellan Professional Products Limited Warranty 

(Europe, Middle East, Africa)

All Magellan Navigation global positioning system 
(GPS) receivers are navigation aids, and are not in-
tended to replace other methods of navigation. Pur-
chaser is advised to perform careful position charting 
and use good judgment. READ THE USER GUIDE 
CAREFULLY BEFORE USING THE PRODUCT.

1. MAGELLAN NAVIGATION WARRANTY

Magellan Navigation warrants their GPS receivers 
and hardware accessories to be free of defects in ma-
terial and workmanship and will conform to our pub-
lished specifications for the product for a period of 
one year from the date of original purchase or such 
longer period as required by law. THIS WARRANTY 
APPLIES ONLY TO THE ORIGINAL PURCHASER OF 
THIS PRODUCT. 

In the event of a defect, Magellan Navigation will, at 
its option, repair or replace the hardware product 
with no charge to the purchaser for parts or labor. The 
repaired or replaced product will be warranted for 90 
days from the date of return shipment, or for the bal-
ance of the original warranty, whichever is longer. 
Magellan Navigation warrants that software products 
or software included in hardware products will be 
free from defects in the media for a period of 30 days 
from the date of shipment and will substantially con-
form to the then-current user documentation provid-
ed with the software (including updates thereto). 
Magellan Navigation's sole obligation shall be the 
correction or replacement of the media or the soft-
ware so that it will substantially conform to the then- 
current user documentation. Magellan Navigation 
does not warrant the software will meet purchaser's 
requirements or that its operation will be uninterrupt-
ed, error-free or virus-free. Purchaser assumes the 
entire risk of using the software.

2. PURCHASER'S REMEDY

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS 
WRITTEN WARRANTY OR ANY IMPLIED WARRAN-
TY SHALL BE LIMITED TO THE REPAIR OR RE-
PLACEMENT, AT MAGELLAN NAVIGATION'S 
OPTION, OF ANY DEFECTIVE PART OF THE RE-
CEIVER OR ACCESSORIES WHICH ARE COVERED 
BY THIS WARRANTY. REPAIRS UNDER THIS WAR-
RANTY SHALL ONLY BE MADE AT AN AUTHORIZED 
MAGELLAN NAVIGATION SERVICE CENTER. ANY 
REPAIRS BY A SERVICE CENTER NOT AUTHO-
RIZED BY MAGELLAN NAVIGATION WILL VOID 
THIS WARRANTY.

3. PURCHASER'S DUTIES

To obtain service, contact and return the product 
with a copy of the original sales receipt to the dealer 
from whom you purchased the product.

Magellan Navigation reserves the right to refuse to 
provide service free-of-charge if the sales receipt is 
not provided or if the information contained in it is 
incomplete or illegible or if the serial number is al-
tered or removed. Magellan Navigation will not be re-
sponsible for any losses or damage to the product 
incurred while the product is in transit or is being 
shipped for repair. Insurance is recommended. Ma-
gellan Navigation suggests using a trackable ship-
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ping method such as UPS or FedEx when returning a 
product for service.

4. LIMITATION OF IMPLIED WARRANTIES

EXCEPT AS SET FORTH IN ITEM 1 ABOVE, ALL 
OTHER EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING THOSE OF FITNESS FOR ANY PARTIC-
ULAR PURPOSE OR MERCHANTABILITY, ARE 
HEREBY DISCLAIMED AND IF APPLICABLE, IM-
PLIED WARRANTIES UNDER ARTICLE 35 OF THE 
UNITED NATIONS CONVENTION ON CONTRACTS 
FOR THE INTERNATIONAL SALE OF GOODS. 

Some national, state, or local laws do not allow limi-
tations on implied warranty or how long an implied 
warranty lasts, so the above limitation may not apply 
to you.

5. EXCLUSIONS

The following are excluded from the warranty cover-
age: 

(1) periodic maintenance and repair or replacement 
of parts due to normal wear and tear; 

(2) batteries; 

(3) finishes; 

(4) installations or defects resulting from installa-
tion; 

(5) any damage caused by (i) shipping, misuse, 
abuse, negligence, tampering, or improper use; (ii) 
disasters such as fire, flood, wind, and lightning; (iii) 
unauthorized attachments or modification; 

(6) service performed or attempted by anyone other 
than an authorized Magellan Navigations Service 
Center; 

(7) any product, components or parts not manufac-
tured by Magellan Navigation, 

(8) that the receiver will be free from any claim for 
infringement of any patent, trademark, copyright or 
other proprietary right, including trade secrets 

(9) any damage due to accident, resulting from inac-
curate satellite transmissions. Inaccurate transmis-
sions can occur due to changes in the position, 
health or geometry of a satellite or modifications to 
the receiver that may be required due to any change 
in the GPS. (Note: Magellan Navigation GPS receiv-
ers use GPS or GPS+GLONASS to obtain position, 
velocity and time information. GPS is operated by the 
U.S. Government and GLONASS is the Global Navi-
gation Satellite System of the Russian Federation, 
which are solely responsible for the accuracy and 
maintenance of their systems. Certain conditions can 
cause inaccuracies which could require modifica-
tions to the receiver. Examples of such conditions in-
clude but are not limited to changes in the GPS or 
GLONASS transmission.).

Opening, dismantling or repairing of this product by 
anyone other than an authorized Magellan Navigation 
Service Center will void this warranty.

6. EXCLUSION OF INCIDENTAL OR CONSEQUEN-
TIAL DAMAGES

MAGELLAN NAVIGATION SHALL NOT BE LIABLE 
TO PURCHASER OR ANY OTHER PERSON FOR ANY 
INDIRECT, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES WHATSOEVER, INCLUDING BUT NOT 
LIMITED TO LOST PROFITS, DAMAGES RESULT-
ING FROM DELAY OR LOSS OF USE, LOSS OF OR 
DAMAGES ARISING OUT OF BREACH OF THIS 

WARRANTY OR ANY IMPLIED WARRANTY EVEN 
THOUGH CAUSED BY NEGLIGENCE OR OTHER 
FAULT OFMAGELLAN NAVIGATION OR NEGLIGENT 
USAGE OF THE PRODUCT. IN NO EVENT WILL MA-
GELLAN NAVIGATION BE RESPONSIBLE FOR 
SUCH DAMAGES, EVEN IF MAGELLAN NAVIGA-
TION HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

Some national, state, or local laws do not allow the 
exclusion or limitation of incidental or consequential 
damages, so the above limitation or exclusion may 
not apply to you.

7. COMPLETE AGREEMENT

This written warranty is the complete, final and ex-
clusive agreement between Magellan Navigation and 
the purchaser with respect to the quality of perfor-
mance of the goods and any and all warranties and 
representations. THIS WARRANTY SETS FORTH ALL 
OF MAGELLAN NAVIGATION'S RESPONSIBILITIES 
REGARDING THIS PRODUCT. 

THIS WARRANTY GIVES YOU SPECIFIC RIGHTS. 
YOU MAY HAVE OTHER RIGHTS WHICH VARY 
FROM LOCALITY TO LOCALITY (including Directive 
1999/44/EC in the EC Member States) AND CER-
TAIN LIMITATIONS CONTAINED IN THIS WARRAN-
TY MAY NOT APPLY TO YOU.

8. CHOICE OF LAW.

This limited warranty is governed by the laws of 
France, without reference to its conflict of law provi-
sions or the U.N. Convention on Contracts for the In-
ternational Sale of Goods, and shall benefit Magellan 
Navigation, its successors and assigns.

THIS WARRANTY DOES NOT AFFECT THE CUS-
TOMER'S STATUTORY RIGHTS UNDER APPLICA-
BLE LAWS IN FORCE IN THEIR LOCALITY, NOR 
THE CUSTOMER'S RIGHTS AGAINST THE DEALER 
ARISING FROM THEIR SALES/PURCHASE CON-
TRACT (such as the guarantees in France for latent 
defects in accordance with Article 1641 et seq of the 
French Civil Code).

For further information concerning this limited war-
ranty, please call or write:

Magellan Navigation SAS - ZAC La Fleuriaye - BP 
433 - 44474 Carquefou Cedex - France.

Phone: +33 (0)2 28 09 38 00, Fax: +33 (0)2 28 09 
39 39
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This Getting Started 
Guide covers both the 

ProMark3 and ProMark3 
RTK systems. 

For the sake of 
simplicity, and unless 

otherwise specified, the 
term “ProMark3” refers 
to both the ProMark3 
RTK and ProMark3 

systems.

”RTK Setup”, ”Standard 
RTK: “Surveying”” and 
”Advanced RTK: FAST 

Survey Option” are 
chapters specific to 

ProMark3 RTK.
1. Introduction

Thank you for buying a ProMark3 RTK or ProMark3 system 
from Magellan.

What is ProMark3?

ProMark3 is a data collector allowing you to perform Survey 
and GIS jobs. It also includes a full set of navigation func-
tions.
ProMark3 includes a large, high-resolution screen and offers 
enhanced communication with Bluetooth, USB and serial 
connections.
ProMark3 can be upgraded into a ProMark3 RTK by installing 
the appropriate firmware available from the Magellan FTP 
server and then enabling the RTK function through a pass-
word. For more information, please refer to Unlocking RTK 
and FAST Survey on page 71. 

What is ProMark3 RTK?

ProMark3 RTK offers the same functions as ProMark3 plus 
the capability to perform real-time, centimeter-accurate sur-
veys using BLADE™, Magellan’s special RTK L1 algorithm. 
From the hardware point of view, ProMark3 RTK is strictly 
similar to ProMark3.
RTK implementation in ProMark3 RTK relies on the use of:
- A base/rover system (base/rover configuration) with its 

dedicated data link (license-free radio),
- A network connection (NTRIP or Direct IP, via GPRS), in 

which case no user-owned base is required (rover-only 
configuration),

- Or any other solution using an external RTCM source (bea-
con, etc.).

To perform your surveys with ProMark3 RTK, you can use ei-
ther the built-in Surveying function or, as an option, the Ma-
gellan FAST Survey software.

System Components Overview

The table below provides an overview of the different key 
items composing the ProMark3. 
1
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Basic Supply:

ProMark3 
Receiver Unit

Handstrap

Two Styli

Accessories, General Pu

I/O Module

AC Adapter/
Charger

USB Cable

(1) Two versions available: U
(111360) and EC (111359).
Two units are needed: one a
base, the other on the rover.
Depending on your purchase, based on the type of survey you 
wish to perform, you may only have part of the listed items. 
Please refer to the delivered packing list for an accurate 
description of the equipment that has been delivered to you.

ProMark3 CD
(User docu-
mentation)

Initializer Bar 
and antenna 
adaptor

Survey-specific accessories:

External 
GNSS 
Antenna

GNSS Solu-
tions CD

RTK specific accessories

External 
Antenna 
Cable

License-free 
radio with its 
power/data 
cable. (1)

rpose: Fastening Accessory Kit

Vertical 
Antenna 
Extension + 
Washer

License-free 
radio bracket

Field Bracket

RTK Vertical 
Antenna Exten-
sion, 0.25 m 
high (10 inches)

Measurement 
Tape

FAST Survey 
CD Option

S 

t the Field Bag

GIS

MobileMapper 
Office CD
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“Pressing the LOG key” 
does not describe the 
same action as “tap-

ping the Log button”.

Tap this icon to show or 
hide the on-screen 

keypad.
ProMark3 Controls

Keyboard
In addition to the 8 specific keys (LOG, NAV, ESC, IN, OUT, 
ENTER, MENU and Power), ProMark3 is fitted with an alpha-
numeric keypad. The cursor keys are used to move the cursor 
left, right, up and down on the screen. Buttons 2-9 contain al-
phanumeric characters. 

Using the Stylus
The stylus is used for menu selection or data input on the 
touch-screen. The following terminology is used:
Tap: Touch the screen once with the stylus to select or open 
an item.
Double-tap: Touch the screen twice rapidly to open a selected 
item.
Drag: Hold the stylus on the screen and drag it across to select 
text. Drag in a list to select multiple items.

Press vs. Tap - Key vs. Button
In this guide, the verb “Press” refers to any action performed 
on the keyboard and “Tap” refers to any action performed with 
the stylus on the touch screen, including on the on-screen 
keypad. Likewise, the name “key” refers to any key on the key-
board and “button” refers to any on-screen pushbutton.

On-Screen Keypad
The ProMark3 screen now continually displays a keypad icon 
in its lower-right corner. This icon gives you permanent control 
over the ProMark3’s on-screen keypad. The icon operates as a 
toggle switch. Any time, you can tap it to show or hide the on-
screen keypad.
Note that the ProMark3 continues to automatically display the 
on-screen keypad when context requires data entry. It disap-
pears when you press ENTER.
3
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Battery Life

Whether used as a rover or 
a base, ProMark3 will run 
for 8 hours with its inter-
nal battery in typical con-

ditions of use. 
2. Preparing For First-Time Use

Charging the ProMark3 Battery Pack

The ProMark3 includes a rechargeable, replaceable battery 
pack. Before using the receiver, you must first charge the bat-
tery pack:
1. Locate the removable battery provided.
2. Open the battery door, located in the back of the receiver, 

using a screwdriver or a coin.
3. Insert the battery –label side upward, contact towards the 

top of the unit– into the battery compartment:

4. Close the battery door and tighten the screws.
5. Attach the Clip-on I/O module to the receiver as shown 

below (Insert bottom first, hold down release button, press 
I/O module against unit and release button):

6. Connect the AC adapter (see below) and then let it charge 
the battery for approximately six hours.

Connect cable from AC 
adapter to this input



E
n
g
li
sh

ProMark3 Start-up Screen
7. To detach the clip-on I/O module, press the release button 
on the module.

Turning On/Off the Receiver

Once you have charged the battery, press the red key (the pow-
er key) on the front of the receiver until the power indicator 
turns solid green.
You will first see the receiver’s start-up 
screen (see opposite left). Wait for the 
progress bar to complete its sequence. 
The screen then displays the ProMark3 
workspace with its main icons (see op-
posite right).
There are three categories of programs 
behind these icons:
- ProMark3 primary functions: Survey-

ing and Mobile Mapping icons.
For a ProMark3 RTK with the FAST 
Survey software option installed and 
unlocked, you will also see the FAST Survey icon.

- DGPS Configuration icon, for a quick access to the DGPS 
configuration options.

- Settings and Utilities icons giving access to the complete 
sets of setup and utility programs.

When you need to turn off ProMark3, simply press the  red 
key until the screen displays the Shut Down window and then 
tap OK.

ProMark3 Workspace
5
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Calibrating the Screen

For the first-time use, you need to align your display screen so 
the cursor on the touch screen align with the tip of your stylus. 
Use the stylus pen to tap the center of each target that ap-
pears on the Calibration screen with the tip of the stylus. Tap 
anywhere on the display when finished.
To re-calibrate your screen at anytime, double-tap the Settings 
icon then double-tap Stylus from the list, tap the Calibration 
tab and then follow the instructions.

Automatic System Time Update

ProMark3 will automatically update the system date & time 
using the GPS time determined by the integrated GPS receiver 
and the time zone that you specify. To set the time zone:
• In the ProMark3 workspace, double-tap the Settings icon.
• Double-tap the Date/Time function. This opens the Date/

Time Properties screen. 
• Set the time zone field (see opposite) and then select OK 

on top of the screen.
Please note that you should wait for a few seconds, after 
turning on ProMark3, before system time can effectively 
be updated.

Adjusting the Backlight

To switch the backlight on/off for both the keypad and display, 
or to adjust the brightness and screen contrast, double-tap the 
Settings icon on the ProMark3 workspace and then double-tap 
the Backlight Control function.
To conserve battery power, we recommend you to switch the 
backlight off whenever possible.
For other settings, please refer to the ProMark3 Reference 
Manual.
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Please Go Outside to Per-

form Initialization!
Initialization is required 
when 1) the receiver is 
brand new, 2) you have 
moved more than 500 

miles from the last place 
you were using it, 3) mem-

ory has been completely 
erased or 4) the receiver 

has not been used for more 
than a few months.
Initializing GPS

Take the receiver to a location where there is a clear view of 
the sky, then:
- From the ProMark3 workspace, tap successively the Utili-

ties icon and then the GPSInit icon.
- Initialize the receiver using one of the two methods below:

1.If you don’t have the slightest idea of what the coordi-
nates of your current position are, check the Choose 
Country option (see screen below left), select respec-
tively your region and country in the two fields under-
neath, enter the date and time (bottom of the screen) 
and then tap OK to start the initialization process. This 
closes the GPS Initialization window.

2.If you have a rough idea of what the coordinates of 
your current position are, directly enter these coordi-
nates in the Latitude and Longitude fields (see screen 
above right), enter the date and time (bottom of the 
screen) and then tap OK to start the initialization pro-
cess. This closes the GPS Initialization window.
7
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Preliminary Settings

From the ProMark3 workspace, do the following:
• Double-tap the Surveying icon if you want to perform a 

real-time (ProMark3 RTK only) or post-processing survey.
• Or double-tap the Mobile Mapping icon if you want to per-

form a GIS job.
Whatever your choice, ProMark3 will then display a navigation 
screen.
Just press the NAV or ESC button to scroll through the differ-
ent available navigation screens.
For more information on Navigation screens, please refer to 
chapter Navigation Tools on page 69.

Access to Preliminary Settings
Now that ProMark3 displays a navigation screen, press the 
MENU key and tap Setup (see screen opposite).
There are many options to select among, and all are explained 
in full in the ProMark3 RTK / ProMark3 Reference Manual 
available from the documentation CD. For the purposes of get-
ting started, however, we will concentrate on just a few of 
these options.
As a general rule, tap an option to open the corresponding set-
ting window. Then tap the desired value. This will enable the 
value and take you back to the Setup menu. You can also re-
turn to the Setup menu by pressing the ESC button.

Choosing the Storage Medium
ProMark3 can store your jobs either in its internal memory or 
on the SD card you have inserted in the unit. Tap the desired 
option.
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Entering the Receiver ID

(From within Surveying function only)
The Receiver ID screen provides you with the ability to enter 
the 4-character receiver ID which is used in naming the raw 
data files. Each raw data file from this receiver will include 
this 4-character receiver ID.

Specifying the Antenna Used
You select this option to define the type of external antenna 
used, its height and the unit used to express this height.
Three different types of antennas are listed (ProMark Antenna 
110454, NAP100 or Other). If you choose “Other”, you will 
have to define the following parameters for your antenna: an-
tenna radius, phase center offset and SHMP offset (slant 
height measurement point offset).

The choices made through the External Antenna option be-
come the default antenna settings for all the ProMark3 survey-
ing and mobile mapping functions.

Choosing the Units
You select this option to set the units of measurement you 
want to use. Units are presented in this order: long distances, 
short distances, speed and area. You can set these units to 
“kilometers, meters, kph and hectares” or “miles, feet, mph, 
acres” if you like, or to three other standard sets of units. You 
can also create a custom mix of units by selecting the Ad-
vanced option that contains a wide variety of units for dis-
tance, speed, elevation, bearing and area.

Antenna Radius

SHMP
Offset

Phase Center 
Offset
9
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Satellite Status screen
Checking that ProMark3 Receives Satellites
Press NAV repeatedly until the Satellite Status screen is dis-
played. This screen shows which satellites the receiver is 
tracking and where they are located in the sky. If you are not 
tracking 3 or more satellites you may have to move to a more 
open area.
When used with its internal antenna (Mobile Mapping only), 
the receiver will have the best view of the sky when you hold 
it at an angle of 45 degrees from horizontal and not too close 
to you.

This allows the internal antenna to function optimally for the 
best accuracy.
In Survey jobs for which the external antenna is mandatory, 
only the vertical orientation of this antenna is important.

45°
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When the base setup is 

under your responsibil-

ity, make sure the base 

is sited in a clear area 

giving the best possible 

view of the sky!

When this is possible, 
avoid trees, buildings 

or any high obstacles in 
the vicinity of the base. 

Having a clear view of 
the sky will allow the 
base to collect data 
from a maximum of 

visible satellites, which 
is highly recommended 

to perform a 
successful, accurate 

and fast survey. 
3. RTK Setup

Introduction to RTK 

Enabling the RTK algorithm in the ProMark3 RTK is simply 
done by launching “Surveying”, pressing MENU, selecting 
Receiver Mode and then Real-Time or Real-Time & Raw Data 
Recording.
From this time on, the ProMark3 RTK will operate to deliver 
fixed position solutions, provided the operating requirements 
are met.
Selecting Real-Time & Raw Data Recording is a safe way to 
perform a real-time survey. With raw data recorded in the 
background, you will have the capability to post-process the 
raw data in the office. This however requires that base raw 
data be also available for the same period of time (see also 
page 39).
The table below summarizes the keywords and principles used 
in the RTK technique. Please carefully read this table before 

getting started.

1. Corrections. Corrections generated by a static receiver 
(“base”) are needed for the rover to be able to deliver 
centimeter-accurate positions. 

2. Data Link. The data link that must be established to 
transfer corrections from the base to the rover can be 
implemented in three different ways with 
ProMark3 RTK: license-free radio, cellular phone 
(GPRS) or any other external RTCM device.

3. Base. Depending on the chosen data link, the base will 
be either:
• A ProMark3 RTK set as a base and generating 

RTCM3.1 corrections.
• Or an external provider delivering its corrections via 

the Internet. In this case, corrections may be the 
following: RTCM3 or RTCM2.3.
11
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4. ProMark3 RTK Configurations

5. Rover Initialization. Before starting a survey, the rover 
must be initialized. There are three possible methods: 
“On The Fly”, “Known Point” and “Bar”. The “Bar” 
method can only be used if you have your own base.
The initialization methods are introduced in the post-
processing chapter (see page 42). The description is 
accurate for real-time processing too. Unlike post-pro-
cessing though, real-time processing tells you in real 
time when initialization is complete.
Compared with post-processing surveying, RTK survey-
ing proposes a fourth initialization method called “Stat-

ic”. With this method, the antenna should stay still over 
an unknown point until initialization is achieved. This 
method gives faster initialization than “On-The-Fly” 
initialization in the same operating conditions.
The time required for initializing the rover ranges from 
a few seconds to a few minutes, depending on the base-
line length, the GPS constellation and the initialization 
method used.
“Known Point” and “Bar” are the fastest initialization 
methods.

6.  Baseline Length. Whatever the base used, its distance 
to the rover, called “baseline” (up to 1.6 km or 1.0 mile 
with license-free radios, up to 10 km with a network 
connection), must roughly be known to make sure RTK 
positions will achieve the expected level of accuracy.

Base/Rover
(Base/rover System)

Rover-Only
(Network Connection)

Base
RoverRadio Data Link Rover

GPRS Data LinkInternet

+ Cell
Phone
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Base/Rover Configuration

You are using your own ProMark3 RTK base to generate the 
RTCM corrections needed by the rover. A pair of Magellan li-
cense-free, plug-and-play radios is used for the data link.

In the Base/Rover Configuration example described in this 
guide:
- “Surveying” is used as the user interface.
- The base is installed on a known point. The coordinates 

of this point were uploaded to ProMark3 RTK from a 
GNSS Solutions project containing this point. This 
means the point is now selectable from the list of control 
points stored in the ProMark3 RTK.
NOTE: Points uploaded to ProMark3 RTK through this 
method always have their coordinates automatically con-
verted to WGS84.

- The “Bar” method is used to achieve rover initialization. 
On the rover, a range pole fitted with a quick release 
adaptor is required to use this method.
13
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1.

5.

6.
2.

3

4

7

Setting Up the Base
The installation site should offer the best possible GPS recep-
tion conditions. The antenna should have a clear view of the 
sky in all directions. There should be no, or a minimum of sat-
ellite obstructions in the vicinity.

1. Set up the tripod / tribrach combination over the point.
2. Screw the RTK vertical antenna extension into the tri-

brach.
3. Insert the kinematic bar on top of the RTK vertical 

antenna extension.
4. Attach the GNSS antenna on top of the kinematic bar.
5. Mount the license-free radio onto its bracket using the 

screws, nuts and washers provided.

10.

8.

12.

H SlantH Vertical

5.

.

.

.

11.

9.
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The higher the radio, the 

better the quality and 
range of the radio link.

Warning!
Unscrewing the radio 
antenna protection is 

pointless or even hazard-
ous for the antenna.
6. Secure the radio bracket onto the RTK vertical antenna 
extension. Place it as high as possible, just underneath 
the GNSS antenna, as shown. Placing the radio too low 
will reduce the radio range.

7. Connect the external antenna cable to the GNSS antenna.
8. Connect the other end of the external antenna cable to the 

ProMark3 RTK. Lift the flap on the side on the unit to 
access the antenna input connector.

9. Connect the radio cable to the back of the receiver. The 
connection is secure after you have fully tightened the 
thumb screw.

10.Place the ProMark3 RTK receiver into the field bracket.
11.Attach the field bracket / ProMark3 RTK combination 

onto the tripod.
12.Measure and record the instrument height (HI) of the 

GNSS antenna.
13.Turn on the ProMark3 RTK and check that the green LED 

indicator on the radio is on. This means the connection 
between the radio and the ProMark3 RTK is correct and 
the radio is normally powered.

Configuring the Base
Remember in this example that the position of the base is 
stored in the ProMark3 RTK as a control point (see page 13). 
Follow the instructions below:
1. Double-tap the Surveying icon.
2. Press MENU, tap Receiver Mode, then Real-Time.
3. Press MENU, tap Base Station and enter the base parame-

ters:
• Site ID: Allows you to quickly enter the coordinates of 

the base: Tap the right-arrow button to the right of the 
field.
15
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This opens a points list from which you can select the 
control point name corresponding to where the base is 
installed. This automatically sets the Location field to 
the right coordinates.

• Station ID: A 4-character string (0.. 4095).
• Location: Coordinates of base position. See Site ID field 

above.
• Elevation: Above ellipsoid.
• Units: Antenna height unit (meters, US feet or Int 

feet).
• Antenna Height: From the reference point.
• Height Type: Slant or Vertical.

4. Tap Start. The ProMark3 RTK starts operating as a base. 
RTCM 3.1 corrections are now broadcast via the radio 
modem. The screen shows the following parameters:
• Site ID: As a reminder
• Elapsed: Time elapsed since you started the base sta-

tion
• # Sats: Current number of satellites received
• PDOP
• Base Station Position
• Power indicator (all green: fully charged)
• Free memory indicator (all green: maximum)

Later, after you have finished your survey and you come back 
to the base to switch it off, first tap Stop. The ProMark3 RTK 
will instantly stop transmitting RTCM corrections.



E
n
g
li
sh

7

6

5

Setting Up the Rover
Install the unit on its range pole:
1. Mount the GNSS antenna on top of 

the pole using a quick release exten-
sion.

2. Mount the radio modem onto its 
bracket using the screws, nuts and 
washers provided.

3. Secure the radio bracket onto the 
pole.

4. Connect the GNSS antenna to the 
ProMark3 RTK using the cable pro-
vided.

5. Connect the radio cable to the back 
of the ProMark3 RTK.

6. Attach the field bracket onto the pole
7. Place the ProMark3 RTK into the 

field bracket
8. Measure the antenna height.

Configuring the Rover
1. Turn on the ProMark3 RTK.
2. Double-tap the DGPS Configuration icon. This opens the 

DGPS Configuration window.
3. Tap Select Mode, select UHF and tap OK. Tap OK again to 

close the DGPS Configuration window.

Initializing the Rover
1. Move the rover antenna from the range pole to the kine-

matic bar (see picture below left), then:
2. On rover side, double-tap the Surveying icon.
3. Press MENU, tap Receiver Mode, then Real-Time.
4. Press MENU and tap Initialize RTK.
5. Select Bar. This opens the Initialization window.

1

2-3

6-7

4

17
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6. Keep an eye on the displayed parameters while the 
receiver initializes:
• Baseline: Baseline length. Should stay 0.0 km in the 

case of a bar initialization.
• Elapsed: Counts the time since you started initializa-

tion.
• # Sats: Should be 6 or more for fast initialization.
• PDOP: Should be less than 3.
• Age: Should stay around 2 seconds. If it starts increas-

ing steadily, this probably means RTCM corrections are 
no longer received. Check your radios.

• Solution: Position solution status. Should be a blinking 
“Float” throughout initialization.
When “Fixed” appears in the Solution field, this means 
the rover is initialized. A new button (OK) then appears 
next to the Cancel button.

7. Tap OK to close the Initialization window.
8. Move the rover antenna from the initializer bar to the top 

of the rover pole (see picture below right). While doing 
this, take care not to mask the rover antenna or else you 
would have to resume initialization.

9. Refer to Standard RTK: “Surveying” on page 24 to start 
your survey.
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3.

2.
Rover-Only Configuration (Network)

Two types of connections are possible: NTRIP and Direct IP. 
Both rely on the use of a Bluetooth-enabled, GPRS-enabled 
cell phone within range of the ProMark3 RTK.
No user-owned base needs to be deployed in this configura-
tion.

Setting Up the Rover
Install the unit on its range pole:
1. Mount the GNSS antenna on the pole
2. Attach the field bracket onto the pole
3. Place the ProMark3 receiver into the field 

bracket
4. Connect the GNSS antenna to the unit 

using the cable provided.
5. Measure the antenna height.

In the Rover-Only Configuration example described in this 
guide:
- “Surveying” is used as the user interface.
- The NTRIP mode is used to acquire RTCM corrections 

from the Internet.
- The “Known Point” method is used to achieve rover ini-

tialization. The coordinates of the known point were 
uploaded to ProMark3 RTK from a GNSS Solutions 
project containing this point. This means the point is 
now selectable from the list of control points stored in 
the ProMark3 RTK.
NOTE: Points uploaded to ProMark3 RTK through this 
method always have their coordinates automatically con-
verted to WGS84.

1.

4.
19
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For step 5, you need to 
know how to activate 
Bluetooth on your cell 

phone and how to make it 
discoverable.

Please refer to its Instruc-
tions Manual.

Your cell phone may also 
ask you for a paired con-

nection with the ProMark3 

RTK. Please accept to be 
able to proceed. 
Configuring the Rover
1. Turn on the ProMark3 RTK.
2. Double-tap the DGPS Configuration icon.
3. Tap the Select Mode button.
4. For our example, select NTRIP and then tap OK. This gives 

access to the NTRIP settings window from which you can 
now do the following:
a) Establish a Bluetooth connection with your cell phone.
b) Establish an Internet connection via the cell phone.
c) Gain access to the NTRIP provider via the cell phone 

and download the provider’s NTRIP source table.

5. To establish a wireless connection between the cell phone 
and the ProMark3 RTK:

• Tap  on the NTRIP Settings window.
• Turn on your cell phone. Activate its Bluetooth device. Make 

its local Bluetooth device discoverable from external Blue-
tooth devices.

• On ProMark3 RTK, tap  to search for the Bluetooth 
devices present in the vicinity. At the end of the search 
sequence, an icon representing your cell phone should be vis-
ible in the Bluetooth Manager window.

• Double-tap the cell phone icon. The Bluetooth Manager win-
dow now shows the Bluetooth services offered by your cell 
phone.

• Double-tap the Dial-Up Networking icon. As a result, a con-
nection is automatically implemented using the first Blue-
tooth virtual port available on ProMark3 RTK. The message 
“Connection succeeded on communication port COMx:” is 
displayed.

• Tap OK to close the message window. Note the presence of a 
plug in a green circle on the Dial-Up Networking icon showing 
that the connection is effective.

• Tap  to close the Bluetooth Manager window. The NTRIP 
Settings window now shows the Bluetooth connection to your 
cell phone.
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For step 6, you need to 
know the GPRS call num-
ber as well as your GPRS 

connection profile (user 
name, password, domain).

Please ask your phone 
operator and/or GPRS pro-

vider if you don’t know 

these parameters.
6. To establish a GPRS connection to the Internet via the cell 
phone:

• Tap  on the NTRIP Settings window.
• In the window that opens, double-tap the Make New Connec-

tion icon.
• Name the new connection (for example “My Cell Phone”) 

using the virtual keyboard, keep Dial-Up Connection checked 
on and then tap Next>. 

• In the Select a modem field, select the port used on 
ProMark3 RTK (i.e. the port assigned previously) to commu-
nicate with the Bluetooth modem of the cell phone (the 
selected modem should be in the form “BT Modem on 
<Cell_Phone_Name> COMx”)

• In the Modem window, tap Next>.
• In the Phone Number field, type the GPRS call number corre-

sponding to your cell phone model and GPRS operator.
• Tap Finish. A new icon appears in the Connection window.
• Double-tap the icon you have just created in the connection 

window.
• Enter the following parameters:

- User Name
- Password
- Domain

• Enable the Save password option.
• Tap on the Dial Properties button and then on the Edit but-

ton. This opens the Edit Dialing Patterns window.
• Correct the content of this window in order to read “G” in the 

three fields.
• Tap OK twice to return to the Dial-up Connection window.
• Tap on the Connect button. The following messages appear 

successively: “Opening Port”, “Dialing...”,... “User Authenti-
cated” and “Connected”. The GPRS connection is now estab-
lished.

• Tap Hide to close the message window.

• Tap  to close the Connection window. The NTRIP Settings 
window now shows the connection to the GPRS operator.
21
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For step 7, you need to 

know your NTRIP connec-
tion profile (host, port, 

login, password).

Please contact your 
NTRIP provider if you 

don’t know these parame-
ters.
7. To choose a station from which to receive RTCM correc-
tions:

• Tap  on the NTRIP Settings window. The NtripCaster Con-
nection window opens in which you can store several NTRIP 
configurations.

• To enter your first NTRIP configuration, with New selected in 
the NTRIP Configuration field, tap on the Add button and 
then enter the following parameters:

- Name: NTRIP Configuration Name (freely choose a name)
- Host: Host IP address
- Port: Port number
- Login: User name
- Password: User password

• Tap OK. The name of the configuration you have just created 
is now pre-selected in the NTRIP Configuration field. Tap OK 
again. This takes you back to the NTRIP Settings window (see 
example opposite).

• Set the Network and Station fields to select the base to work 
with.

• Tap OK. This takes you back to the DGPS Configuration win-
dow. On top of the screen, you can read part of the settings 
you have just made.

• Tap the Connect button. The DGPS Configuration screen now 
indicates the amount of incoming data packets (bottom of the 
screen) as well as the status of the DGPS mode (top of the 
screen).

• Tap OK to close the DGPS Configuration window. The follow-
ing two messages are displayed successively: “Please wait...” 
and “Processing incoming data packets...”.

• Tap OK to close the message window.
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Initializing the Rover

Remember in this example that the position of the point used 
for initializing the system is stored in the ProMark3 RTK as a 
control point (see page 19). Follow the instructions below:
1. Hold the pole in vertical position over the known point.
2. Double-tap the Surveying icon.
3. Press MENU, tap Receiver Mode, then Real-Time.
4. Press MENU and tap Initialize RTK.
5. Tap Known Point.
6. Tap the name of the known point from the displayed list. 

This opens the Initialization window.
7. Keep an eye on the displayed parameters while the 

receiver initializes:
• Baseline: Baseline length.
• Elapsed: Counts the time since you started initializa-

tion.
• # Sats: Should be 6 or more for fast initialization.
• PDOP: Should be less than 3.
• Age: Should stay around 2 seconds. If it starts increas-

ing steadily, this probably means RTCM corrections are 
no longer received. Check your connection to the cor-
rections provider.

• Solution: Position solution status. Should be a blinking 
“Float” throughout initialization.
When “Fixed” appears in the Solution field, this means 
the rover is initialized. A new button (OK) then appears 
next to the Cancel button.

8. Tap OK to close the Initialization window.
9. Refer to Standard RTK: “Surveying” on page 24 to start 

your survey.
23
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4. Standard RTK: “Surveying”

It is assumed that RTK has been implemented according to 
the instructions provided in chapter RTK Setup on page 11.
Once the rover has been initialized (see page 17 or page 23, 
depending on whether you are in base/rover or rover-only con-
figuration), you can move on to the survey as such. Always 
take care to maintain maximum satellite visibility from the an-
tenna in order to preserve system initialization.
If the rover loses initialization, you will need to resume this 
step using whichever initialization method is preferable in 
your context of use (see page 12).

Logging Points in Real Time

1. Walk to the first point you want to log and stand still on 
that point.

2. Press the LOG key and then enter the following parame-
ters:
• Site ID: A 4-character string.
• Survey Mode: Logging Point.
• Site Description: An optional 20-character narrative 

description of the point. Tap inside the field, enter 
your text from the on-screen keypad and press ENTER.

• Antenna Height: From the reference point.
• Units: Antenna height unit (meters, US feet or Int 

feet).
• Height Type: Slant or Vertical.
• Time on site (sec): Time, in seconds, that must elapse, 

with the antenna not moving, before the rover stores 
the position of the point (default: 15 seconds). You 
decide the duration of the occupation (If it is greater 
than 1 second, the position solutions will be averaged 
over this period of time to improve accuracy. If it is 
1 second, there is no position averaging but work 
proceeds more quickly).
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If the point you save has a 

“Fixed” solution, then it is 
stored as a control point.

 

This means it can later be 
selected from the list of 

control points to initialize 

the system with the rover 
precisely located over this 

point. 
3. Tap the OK button. This opens a new screen on which you 
can see the following parameters:
• The name of the opened log file is shown in the title 

bar between brackets.
• Baseline: Baseline length in km
• Solution: Solution status. Check that it is “Fixed” for 

centimeter accuracy.
• Receiver status:

SV: Number of received SVs. Should be 6 or more.
PDOP: Should be less than 3.
Age: Age of corrections (should not be greater than 
2 sec).
HRMS and VRMS: Should be in the order of 
0.03 meters (1.2 inches) when the position is 
fixed. Always displayed in meters whatever the cho-
sen distance unit.

• Your position’s current coordinates, as determined by 
the system.

4. If you are satisfied with the quality of the displayed data, 
tap the on-screen LOG button. This opens a new screen on 
which you can now see the Remain field count down. When 
Remain=00:00:00, the STORE button appears at the bot-
tom of the screen (see screen below right).

5. Tap the STORE button. This saves the point position and 
takes you back to the Logging Point screen where you can 
see that the Site ID has automatically been incremented by 
one.
25
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6. Move to the next point you want to log.
7. Resume steps 3 through 6 as many times as necessary.
8. When all points have been logged, tap DONE on the 

screen. This closes the open log file, which now contains 
the positions of all the logged points, and takes you back 
to the last displayed navigation screen.

Logging Trajectories in Real Time

1. Walk to the start point of the trajectory and stand still on 
that point.

2. Press the LOG key and then enter the following parame-
ters:
• Site ID: A 4-character string.
• Survey Mode: Kinematic.
• Site Description: An optional 20-character narrative 

description of the point. Tap inside the field, enter 
your text from the on-screen keypad and press ENTER.

• Antenna Height: From the reference point.
• Units: Antenna height unit (meters, US feet or Int feet)
• Height Type: Slant or Vertical.
• Interval Type: Time or Distance, according to whether you 

want the points of the trajectory to be created and 
logged at regular intervals of time or distance.

• Interval: Time elapsed, in seconds, or distance traveled, 
in meters, between any two point positions logged 
along the trajectory followed.
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3. Tap the OK button. This opens a new screen on which you 

can see the following parameters:
• The name of the opened log file is shown in the title 

bar between brackets.
• Baseline: Baseline length
• Solution: Solution status. Check that is “Fixed” (for 

centimeter accuracy). 
• Receiver status:

SV: Number of received SVs. Should be 6 or more.
PDOP: Should be less than 3.
Age: Age of corrections (should not be greater than 
2 sec).
HRMS and VRMS: Should be in the order of 
0.03 meters (1.2 inches) when the position is 
fixed. Always displayed in meters whatever the cho-
sen distance unit.

• Your position’s current coordinates, as determined by 
the system.

4. Tap the START button to start logging the trajectory.
5. Walk along the trajectory and let the system operate on its 

own. You can see that the Site ID is automatically incre-
mented as you walk. Note that using the PAUSE button, 
you can pause the position logging if you need to do so.

6. When you have reached the end of the trajectory, tap the 
DONE button. This closes the open log file, which now 
contains the positions of all the logged points along the 
trajectory, and takes you back to the last displayed naviga-
tion screen.
27
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Staking Out

1. Press the LOG key and then enter the following parame-
ters:
• Survey Mode: Stakeout.
• Antenna Height: From the reference point.
• Units: Antenna height unit (meters, US feet or Int 

feet).
• Height Type: Slant or Vertical.
• Time on site (sec): Time, in seconds, that must elapse, 

with the antenna not moving, before the rover stores 
the position of the point (default: 15 seconds). You 
decide the duration of the occupation (If it is greater 
than 1 second, the position solutions will be averaged 
over this period of time to improve accuracy. If it is 
1 second, there is no position averaging but work pro-
ceeds more quickly).

• Enter coordinates manually check button: Do not check 
this button if the points you want to stake out are con-
trol points already stored in memory. Check it on if you 
want to enter the coordinates for a point to stake out.

2. Tap the OK button. Depending on how you set the Enter 
coordinates manually check button, the receiver now dis-
plays the list of control points, so you can select one 
(below left), or asks you to enter the coordinates of the 
point to stake out (below right). In the latter case, make 
sure the coordinate system used is the right one (MENU 
key> Setup> Coord Sys).
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3. After you have selected a point from the list or entered 
coordinates manually, the ProMark3 RTK switches to the 
last selected navigation screen.

4. Follow the instructions on the screen to get closer to the 
stakeout point. When the distance to the point is only 
about one meter, the screen displays the following:

5. Check the distances displayed at the top of the screen. 
Move the pole to zero these values (see diagram above 
left). Carefully plumb the pole for precise staking. The dis-
played distances should be interpreted as follows:
• East 0.233 M means you must move east to zero this 

value.
• North 0.367 M means you must move north to zero 

this value.
6. When these values are all zero, stop moving. You are on 

the point.
7. Set the stake.
8. You may want to take another reading to save the as-

staked position. Obviously, this position should be the 
same as that of the stakeout point but later you can com-
pare your field work with the target coordinates.

East
Distance

North 
Distance

Target Point

0, 0
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To save the as-staked position:
• Tap the OK button. This opens a new screen on which 

you can now see the Remain field count down. In the 
window’s title bar is the name of the log file where the 
position is about to be saved. Note that a non-editable 
Site ID, different from the name of the target point, is 
automatically assigned to that position. GNSS Solu-
tions will automatically make the correspondence 
between the target point and the saved position.
When Remain=00:00:00, the STORE button appears at 
the bottom of the screen (see screen below right).

• Tap the STORE button. This saves the point position 
and takes you back to the stakeout screen. 

9. Tap Next to display the list of control points from which 
you can select a new target point.

10.Resume steps 4 through 7 until all the points have been 
staked out, then tap Done to end the stake out survey. This 
takes you back to the last displayed navigation screen.
If you have also logged the positions where you placed 
your stakes, tapping Done also closes the log file contain-
ing the measured positions of all these points.

Quitting The Surveying Function

Press the MENU key and tap Exit. This takes you back to the 
ProMark3 RTK workspace.



E
n
g
li
sh
5. Advanced RTK: FAST Survey Option

Introduction

The two requirements for running FAST Survey are: 1) You are 
using a ProMark3 RTK and 2) FAST Survey has been un-
locked.

Launching FAST Survey
From the ProMark3 RTK workspace, double-tap the FAST Sur-
vey icon to launch FAST Survey. The software takes full control 
of the platform and re-assigns new functions to the function 
keys. See re-allocation table on page 72.

Creating a New Job
FAST Survey first asks you to open a job (a crd file). Do the 
following:
1. Choose Select New/Existing Job. A new screen is now dis-

played.
2. In the Name field, type in the name of the job you wish to 

create. For example, type in “tuto1.crd”.
3. Then tap OK to create the job. The screen then displays 

the Units tab.
4. On the Units tab, set the desired units and parameters for 

the job.
5. Tap on the GPS tab.

On the GPS tab, choose the coordinate system to be used 
in the job as well as the geoid model. A large number of 
coordinate systems are stored in FAST Survey. To select 
one of them, click on the Edit Projection List button and 
then Add Predefined. Some coordinate systems require that 
a datum grid (or projection grid) be uploaded before you 
are allowed to use them. Geoids can be uploaded using 
GNSS Solutions.

6. After selecting all the desired parameters, click OK 
(located on top of the screen).
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Configuring a Base
It is assumed that the ProMark3 RTK base has been set up as 
explained in RTK Setup on page 11. If you want to use the Bar 
method to initialize the rover, don’t forget the kinematic bar 
between the antenna and the tribrach.

1. Tap on the Equip tab.
2. Tap the on the Instrument button.
3. Select ProMark3 Magellan Base and tap OK.
4. Tap on the Configure Base button, define the antenna 

height and type as well as the elevation mask.
If you intend to log base raw data, check on the Data 
Recording option, set the recording interval in seconds, 
define the media where to store the data (SD Card or 
Internal memory) and enter a Unit ID. Reminder: This 
parameter is used as header in raw data filenames.

5. Tap OK to enter all these settings. FAST Survey then asks 
you to enter the position of the base and then the refer-
ence station ID.

6. When base configuration is complete, FAST Survey asks 
you to save the base settings in a ref file (<job_name.ref). 
The ProMark3 RTK will then run as a base until you exit 
FAST Survey.

Configuring a Rover
It is assumed that the ProMark3 RTK rover has been set up as 
explained in RTK Setup on page 11.

1. Tap on the Equip tab.
2. Tap the on the Instrument button.
3. Select ProMark3 Magellan Rover and tap OK.
4. Tap on the Rover Settings button, define the antenna 

height and type as well as the elevation mask. Indicate the 
type of position solution that is expected from the rover 
(“Float” or “Fixed” status).
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If you intend to log rover raw data, check on the Data 

Recording option, set the recording interval in seconds, 
define the media where to store the data (SD Card or 
Internal memory) and enter a Unit ID. Reminder: This 
parameter is used as the header in raw data filenames.

5. Tap OK to enter all these settings and complete the rover 
configuration.

Initializing the Rover
1. Tap on the RTK Initialization button (Equip tab)
2. Select the type of initialization you wish to use (see oppo-

site) and then follow the instructions on the screen.
NOTE: Except for “On The Fly Initialization”, the message 
“Please do not move the antenna until the position is Fixed!” 
will appear when you choose an initialization method. Tap 
OK to close this message window.

3. After you have selected an initialization method, FAST 
Survey will switch to the Monitor/Skyplot screen. This 
screen shows the progress of the initialization phase 
(HRMS, VRMS, Status, Latency, etc.).

4. A beep can be heard when the position solution is fixed. 
You can then tap BACK at the top of the screen and move 
on to your survey, taking care not to lose system initializa-
tion.
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Logging RTK Points

1. Tap on the Surv tab and then on Store Points. The screen 
now displayed allows you to log all your points.
The figure below summarizes all the functions available 
from that screen.

For example, you are on a point that you want to log. Do 
the following:

2. Type in the point name and description in the correspond-
ing two fields (see above)

3. Tap on the “A” button
4. Enter the number of readings you want before FAST Sur-

vey is allowed to compute an average position for this 
point. For example, type in “5” and tap OK.
Messages follow successively indicating that the system is 
taking the 5 requested readings. Then FAST Survey dis-
plays the average coordinates it has determined.

5. Tap OK if you agree. The “Point Stored” message appears 
briefly. The screen then shows the location of the point 
together with its name and description.

g point
th offset

GNSS antenna height
 related 
 figures

me and 
o fields

Graphic Display area

Your current position 
and heading

g point
al case)

Provides access to 
monitor screen

Viewing parameters
Zoom settings

Logging point with
position averaging Configures general 

case of point logging

atus of 
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6. After logging all your points, tap MENU in the upper-right 

corner of the screen to return to the menu.

Logging RTK Points in Continuous Mode

1. On the Surv tab, select the Auto by Interval function. Two 
different modes are possible: Time or Distance.

2. If you choose Distance, enter the horizontal and vertical 
increment value respectively in the X/Y and Z fields, 
according to the chosen unit. If you choose Time, enter the 
increment value, in seconds.

3. Enter a point Id. for the start point in the Starting Pt ID 
field. This field will be incremented by one after each 
point logging. You do not need to define a name finishing 
with a figure. FAST Survey will place one anyway when 
incrementing this field.

4. Press OK to switch to the graphic screen (see figure below) 
and start logging the first point.

The S button lets you instantly log the position of a point.
The X button allows you to pause data logging in continu-
ous mode.
If data logging in continuous mode is paused, you can still 
continue to log points in manual mode using the S button.

Used to pause/resume 
data logging

Point Id.
incremented

automatically

Used to log a point’s 
position manually
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Name of poin
be staked
Tap the X button again (changed into a right arrow during 
pause) to resume data logging in continuous mode.
If you come back to the main menu by tapping on MENU, 
then data logging in continuous mode is automatically 
stopped.

Staking out RTK Points

1. Tap on the Surv tab and then select Stakeout Points. The 
screen now displayed allows you to stake out your points.

2. On this screen, FAST Survey asks you to choose the point 
you want to stake out. You can either type in its coordi-
nates in the Northing, Easting and Elevation fields, or select 
a pre-defined point from the points list (see File>List 
Points). You can also, define graphically this point by tap-
ping on the point on the graphic screen, or define that 
point according to azimuth, slope and horizontal distance.

oint 
 out

t to 
 out Provides access to 

graphic screen

Provides access to points list. 
Example of points list:
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Provides access to the
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Stakeout screen

Detailed stakeout scre
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Point to be stak
3. Once you have chosen a point, tapping on the OK button 
will display a graphic screen from which you can easily 
stake out your point:

The target radius is automatically changed as the distance 
from you to the point changes.
When getting closer to the point, markers appear at the 
four corners of the target (see below left) informing you 
that you nearly are on the point. You can now set the stake 
and log the position of this point.

4. Tapping on the STORE button allows you to start perform-
ing measurements to determine the position of the point.

Your current position and 
heading

Provides access to 
monitor screen

Takes you back to the point 
selection screen

Point to be staked out (target) detailed 
en below

en

ext point

he point

osition 
ading

ed out

Used to select which guidance 
data to display

Used to select which data to 
display for the point: 
coordinates or quality data

Configures general 
case of point logging
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The number of measurements will depend on the value 
entered earlier through the File tab>Configure Readings 
function. Once the position has been determined, FAST 
Survey displays the results of the computation so that you 
can check them (see below right).

5. Tap OK if you are satisfied with the results. FAST Survey 
will then save these results and will take you back to the 
stakeout screen for the next point.
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Make sure the base is sited 
in a clear area giving the 

best possible view of the 
sky!

When this is possible, 
avoid trees, buildings or 

any high obstacles in the 
vicinity of the base. 

Having a clear view of the 
sky will allow the base to 
collect data from a maxi-
mum of visible satellites, 

which is highly recom-
mended to perform a suc-
cessful, accurate and fast 

survey. 
6. Post-Processing Surveying

Reminder on Surveying Techniques

Static
Typical Use: Surveying a New Control Point.

Key Instructions: 

1. Two units needed: one (the base) operated on an accurately known 
position and the other (the rover) on the point to be surveyed. There 
can be several rovers logging data at the same time.

2. Approximate distance between the two units (baseline) must be 
known.

3. Data must be collected simultaneously by the two units. Use the 
same logging interval on both units.

4. Observation time is determined by last unit set up (start) and first unit 
turned off (end). We recommend that you start the base first and you 
turn it off last.

5. Required observation time mainly depends on distance between the 
two units (+ reception conditions). Rover unit estimates observation 
time needed.
When Obs. Range on screen is equal to or greater than the baseline, 
you can stop collecting data.

Data collected on surveyed point:

Base

Baseline
(Range)

Observation time

Data collected at base:
Time Organization

Equipment Involved -
Field Organization

Known Point Survey Point

Rover
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Make sure the base is sited 
in a clear area giving the 
best possible view of the 

sky!

When this is possible, 
avoid trees, buildings or 

any high obstacles in the 
vicinity of the base. 

Having a clear view of the 
sky will allow the base to 
collect data from a maxi-
mum of visible satellites, 

which is highly recom-
mended to perform a suc-

cessful and accurate 
survey. 
“Stop & Go”
Typical Use: Surveying Several Points within a Relatively 
Small Area.

Key Instructions: 

1. Two units needed: one stationary (the base) and the other (the rover) 
moved successively on the points to be surveyed. There can be several 
rovers logging data at the same time.

2. Survey must start with an initialization phase (see page 42).
3. Once initialization is achieved, be careful not to mask the rover’s 

GNSS antenna throughout the survey. In case of satellite signal 
loss, you will have to resume the initialization phase.

4. Data must be collected simultaneously by the two units. We recommend 
that you start the base first and you turn it off last. Use the same log-
ging interval on both units. Rover collects data continuously 
throughout the survey.

5. User-preset occupation (observation time) on each surveyed point. 
Defaults: 5 min. on init point, 15 sec. on surveyed points. Countdown 
tells the user when he/she can move to the next point.

Data collected by rover:

Base

Data collected at base:
Time Organization

Equipment

Known Point Survey Point

Rover

Field Execution
Base

0001
0002

0003

0004

000500060007

0001 0002 0003 0004 0005 0006 0007

Occupation: 15 sec. typical

Init

Rover
Init Point
See page 42

5 min. with bar
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Make sure the base is sited 

in a clear area giving the 
best possible view of the 

sky!

When this is possible, 
avoid trees, buildings or 

any high obstacles in the 
vicinity of the base. 

Having a clear view of the 
sky will allow the base to 
collect data from a maxi-
mum of visible satellites, 

which is highly recom-
mended to perform a suc-

cessful and accurate 
survey. 
Kinematic
Typical Use: Surveying Trajectories.

Key Instructions: 

1. Two units needed: one stationary (the base) and the other (the rover) 
moved along each surveyed trajectory. There can be several rovers 
logging data at the same time.

2. Survey must be preceded by an initialization phase (see page 42).
3. Once initialization is achieved, be careful not to mask the rover’s 

GNSS antenna throughout the survey. In case of satellite signal 
loss, you will have to resume the initialization phase.

4. Data must be collected simultaneously by the two units. We recom-
mend that you start the base first and you turn it off last. Use the 
same logging interval on both units. Rover collects data continu-
ously throughout the survey.

5. Site ID is automatically incremented along the trajectory according to 
the recording interval used. 

Data collected by rover:

Base

Data collected at base:
Time Organization

Equipment

Known Point Survey Point

Rover

Field Execution Log

0001...

Done

0015...

0001...

0015...

Init

Base

Log

Pause

Rover

Init Point
See page 42

5 min. with bar
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required to ensure that 
your kinematic surveys, 

whether continuous or Stop 
& Go, will reach centime-

ter-level accuracies through 
post-processing.

With the “Known” method, 
you can make a survey at a 

fairly long distance from 
the base. 

Conversely, with the “Bar” 
method (the method we 

recommend), your survey 
will necessarily start from 

the base and obviously the 
points to be surveyed 

should not be too far away 
from the base.

With the “<None>” 
method, the survey start 

point can be any point but 
you should have a rough 

idea of the distance from 
your working area to the 

base so you can estimate 
the overall time you should 
spend collecting data (15 

to 30 minutes typical) 
Initialization Methods
Three possible methods, from fastest to slowest:
• Known: Initialization on Known point. 

• Bar: On Initializer Bar Installed at the Base

• <None>: On The Fly (OTF) Initialization 

1. You need to specify the Site ID of the known point (surveyed in a previ-
ous job or downloaded from office software).

2 GNSS antenna held stationary over known point for about 15 seconds
3. Countdown indicates when initialization is achieved.

1. You freely enter a Site ID for the rover’s start point
2. GNSS antenna held stationary on the initializer bar for about 5 minutes.
3. Countdown indicates when initialization is achieved.
4. Move the antenna from the bar to the range pole taking care not to 

mask the antenna while doing this. Then start your job

1. You freely enter a Site ID for the rover’s start point
2. There is no countdown indicating when initialization is achieved.

Initialization achieved 
in 15 seconds
Init point can be several kilo-
meters away from the base.

Init point is a known 
point

RoverBase

Known Point
This vector is accurately known

Initialization
achieved
in 5 minutes
Init point is 20 cm 
off the base loca-
tion.

Base

Known Point

1 2Initializing... Move antenna to range pole 
once countdown complete.

Rover

No initialization point

Rover’s start point is 
an unknown point

RoverBase

Known Point

D
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Typical setup with tripod is 
described here.

You can also use a fixed-
height tripod.

4.
Running a Static Survey

Equipment Setup
The equipment setup instructions are the same for both the 
base and the rover. Install and run the base first.
In both cases, the installation site should offer the best pos-
sible GPS reception conditions. The antenna should have a 
clear view of the sky in all directions. There should be no, or 
a minimum of satellite obstructions in the vicinity.

1. Set up the tripod / tribrach combination over the point.
2. Attach the vertical extension bar and a tribrach adapter to 

the GNSS antenna.
3. Place the GNSS antenna assembly on the tripod.
4. Place the ProMark3 receiver into the field bracket.
5. Attach the field bracket / ProMark3 combination onto the 

tripod.
6. Connect the GNSS antenna cable to the unit.
7. Measure and record the instrument height (HI) of the 

GNSS antenna.

1.

2.

3.

5.

6.

7.

H SlantH Vertical
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Satellite Status screen
Static Survey Setup
It is assumed that you have already run all the instructions de-
tailed in Chapter 2. Preparing For First-Time Use on page 4. 
Follow the instructions below to run both the base and the rov-
er.

1. Turn on the receiver by pressing the  red key.
2. Double-tap the Surveying icon.
3. If you have a ProMark3 RTK, press MENU, tap Receiver 

Mode and then Post-processing.
4. Press the NAV key until you see the Satellite Status screen 

(see opposite). Wait until at least 4 satellites are received.
5. When there is enough satellites received, press the LOG 

key. The Survey Settings screen opens.

6. Enter the following parameters:
• Site ID: A 4-character string.
• Survey Mode: Static.
• Site Description: An optional 20-character narrative 

description of the point.
• Antenna Height: From the reference point.



E
n
g
li
sh

VerticalSlant
• Units: Antenna height unit (meters, US feet or Int feet)
• Height Type: Slant or Vertical.
• Recording Interval: Time in seconds between any two 

consecutive acquisitions of GPS data. Make sure the 
same recording interval is used at the base and in the 
rover.

• Control Point check box: If you check this box, you will 
be able, later on, to use the point associated with this 
Site ID as a control point.

Data Collection
7. Tap the Log button at the bottom of the screen.

The Static Survey screen opens providing information on 
the status of your survey during the data collection period.

Information provided here will help you determine when 
enough data has been collected.
45
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Make sure the rover 
antenna will have the best 
possible view of the sky at 
all times during the sur-
vey. This should result in 
#Sats continuously greater 
than 4 and PDOP continu-

ously less than 4.

Obs. Range is equivalent to 
Obs. Timer in ProMark2.
8. Watch the following data on the rover unit:
• Obs. Range (Observation Range): Indicates the maxi-

mum length of the baseline that could be accurately 
determined through post-processing considering the 
amount of data currently collected. The more you col-
lect data, the longer this baseline.

• Elapsed: Time elapsed since data collection began.
• # Sats: Number of received satellites.
• PDOP: Current PDOP value.

9. When according to the Obs. Range parameter on the rover, 
enough data has been collected in this observation ses-
sion, tap the Done button at the bottom of the screen or 
press the ENTER key.

10.Follow the steps presented above for each observation 
session required to complete your survey. After data col-
lection is complete, take all ProMark3 receivers used in 
the survey to the office and download the data to an office 
computer as described in Downloading Raw Data on 
page 62. The data is now ready for post-processing using 
GNSS Solutions.

Running a “Stop & Go” Survey

This chapter describes a typical Stop & Go survey in which ini-
tialization is performed using the initializer bar. (This is the 
initialization method recommended by Magellan.)
It is assumed that you have already run all the instructions de-
tailed in Chapter 2. Preparing For First-Time Use on page 4.
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 Allowing for kinematic ini-
tialization using Initializer 

bar at the base

1.
Base Setup and Operation
The base is setup and operated in the same way as it is in stat-
ic surveys (see page 43). The only difference is the use of the 
initializer bar at the base station.
The base antenna should be centered and levelled above the 
known point. To be able to use the initializer bar for initializa-
tion, be sure to incorporate the bar as part of the base setup 
as shown opposite.

Rover Setup
Install the unit on its range pole:
1. Attach the field bracket onto the pole.
2. Place the ProMark3 receiver into the field 

bracket.
3. Connect the GNSS antenna cable to the unit.
4. Mount the GNSS antenna at the end of the 

base’s initializer bar.
5. Connect the other end of the antenna cable to 

the rover antenna.
2.

3.

4.

5.
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Satellite Status screen

VerticalSlant
Stop & Go Survey Rover Setup

1. Turn on the receiver by pressing the  red key.
2. Double-tap the Surveying icon.
3. If you have a ProMark3 RTK, press MENU, tap Receiver 

Mode and then Post-processing.
4. Press the NAV key until you see the Satellite Status screen 

(see opposite). Wait until at least 4 satellites are received.
5. When there is enough satellites received, press the LOG 

key. The Survey Settings screen opens.
6. Enter the following parameters:

• Site ID: A 4-character string.
• Survey Mode: Stop -and-go.
• Site Description: An optional 20-character narrative 

description of the point.
• Antenna Height: Distance from the rover antenna 

mounted on the bar to the ground.
• Units: Antenna height unit (meters, US feet or Int feet)
• Height Type: Slant or Vertical.
• Recording Interval: Time in seconds between any two 

consecutive acquisitions of GPS data. Make sure the 
same recording interval is used at the base and in the 
rover.

• Initialize: Bar.
• Time on Site (sec): Occupation time on initializer bar for 

the rover antenna (default: 300 seconds).
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Initialization count-down. 
Initialization Phase
7. Tap the Log button at the bottom of the screen.

A screen is displayed showing the counting-down of the 
initialization phase (see screen opposite). The Remain field 
will count down beginning from the value of the Time on 
site field set on the Survey Settings screen. At the end of 
the countdown sequence, the Remain field reads 
“00:00:00”.

8. Move the rover antenna from the initializer bar to the top 
of the rover pole (see illustration below). While doing this, 
take care not to mask the rover antenna or else you would 
have to resume the initialization.
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Make sure the rover 
antenna has the best pos-
sible view of the sky at all 
times during the survey. 

This should result in #Sats 
continuously greater than 
4 and PDOP continuously 

less than 4.

The Obs. Range field is 
irrelevant to the Stop & Go 

mode and for this reason 
is left blank.
Data Collection
9. Walk to the 1st point you want to survey. Be careful not to 

mask the antenna as this might cause loss of satellite sig-
nals.

10.Press the LOG key (not the on-screen Log button). The 
Survey Settings screen is displayed allowing you to change 
the following parameters:
• Site ID and Site Description: Change these two fields if 

required.
• Antenna Height: New height of the rover antenna now 

located on top of the pole.
• Initialize: Check that <None> is now selected
• Time on Site: Enter the occupation time needed on each 

point that you will survey (typically 15 seconds).
11.While holding the pole stationary above the point, tap Log 

on the screen. The receiver then displays the screen below 
left.

12.Wait until Remain=00:00:00. The receiver then displays 
the screen below right.
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Crosses indicate where 
static occupations take 

place.

0001
0002

0003

0004

000500060007

Rover

3.

2.
Note that the content of the Site ID field is incremented by 
1 after ending static occupation on a point (increment: 0 
to 9, then A to Z, then 0.. again, etc.). You can however 
change the Site ID between any two occupation times by 
pressing the LOG key (not the on-screen Log button) and 
editing the Site ID field.

13.Move to the next point and resume the above two steps 
until all the points have been visited.

14.Tap Done after surveying the last point. This completes 
the data collection phase.

Running a Kinematic Survey

This chapter describes a typical Kinematic survey in which 
initialization is performed on a known point (The fastest ini-
tialization method.)

Base Setup and Operation
The base is setup and operated in the same way as it is in stat-
ic surveys (see page 43).

Rover Setup
Install the unit on its range pole:
1. Mount the GNSS antenna on the pole
2. Attach the field bracket onto the pole
3. Place the ProMark3 receiver into the field 

bracket
4. Connect the GNSS antenna to the unit 

using the cable provided.
5. Measure the antenna height.

1.

4.
51



52

E
n
g
lish

Satellite Status screen

VerticalSlant
Kinematic Survey Rover Setup
It is assumed that you have already run all the instructions de-
tailed in Chapter 2. Preparing For First-Time Use on page 4.

1. Turn on the receiver by pressing the  red key.
2. Double-tap the Surveying icon.
3. If you have a ProMark3 RTK, press MENU, tap Receiver 

Mode and then Post-processing.
4. Press the NAV key until you see the Satellite Status screen 

(see opposite). Wait until at least 4 satellites are received.
5. When there is enough satellites received, press the LOG 

key. The Survey Settings screen opens.
6. Enter the following parameters:

• Survey Mode: Kinematic.
• Antenna Height: Distance from the rover antenna 

mounted on top of the pole to the ground.
• Units: Antenna height unit (meters, US feet or Int feet)
• Height Type: Slant or Vertical.
• Recording Interval: Time in seconds between any two 

consecutive acquisitions of GPS data. Make sure the 
same recording interval is used at the base and in the 
rover.

• Initialize: Known. On selecting this option, the unit asks 
you to indicate the Site ID of the control point where 
initialization will take place.
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Initialization count-down. 
After selecting a point from the prompted list (see fig-
ures below), the unit will set the Site ID and Site 
Description fields accordingly.

• Time on Site (sec): Occupation time on known point 
(default: 15 seconds).

Initialization Phase
7. Tap the Log button at the bottom of the screen.

A screen is displayed showing the counting-down of the 
initialization phase (see screen opposite). The Remain field 
will count down beginning from the value of the Time on 
site field set on the Survey Settings screen. At the end of 
the countdown sequence, the Remain field is replaced with 
the Elapsed field which reads “00:00:00”.

Data Collection
8. Walk to the start point of the trajectory you want to survey. 

Be careful not to mask the antenna as this might cause 
loss of satellite signals.
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Make sure the rover 
antenna has the best pos-
sible view of the sky at all 
times during the survey. 

This should result in #Sats 
continuously greater than 
4 and PDOP continuously 

less than 4.

The Obs. Range field is 
irrelevant to the kine-

matic mode and for this 
reason is left blank.

Bold lines indicate the tra-
jectories surveyed.

Log
0001...

0015...

Log

Pause

Rover
9. Tap the on-screen Log button and then walk along the tra-
jectory. The screen then looks like this:

As you are progressing along the trajectory, the content of 
the Site ID field will be incremented by 1 at the recording 
interval rate (increment: 0 to 9, then A to Z, then 0.. 
again, etc.).
Use the buttons at the bottom of the screen to do the fol-
lowing:
• Pause: Tap this button when you arrive at the end of 

the trajectory. The button is then renamed “Log”. Tap 
the Log button when you are at the start point of a new 
trajectory you want to survey. Be careful not to mask 
the antenna between the two trajectories.

• Done: Will end the kinematic survey by closing the 
data file and taking you back to the last displayed nav-
igation screen. (After selecting Done, the receiver is 
idle but still in the Surveying function.)

Quitting the Surveying Function

Press the MENU key and tap Exit. This takes you back to the 
ProMark3 workspace screen.
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Satellite Status screen
7. Mobile Mapping

This guide presents the Mobile Mapping function in its 
simplest implementation, i.e. using the ProMark3’s internal 
antenna and with no differential mode enabled.
With a ProMark3 RTK using an external antenna, Mobile 
Mapping can also be run in RTK mode, thus offering the same 
accuracy level as in surveying.
Once you know how to perform RTK surveys with 
ProMark3 RTK (see RTK Setup on page 11), it’s easy to 
understand how you can extend the use of RTK to Mobile 
Mapping. However, the current position status (“Float”, 
“Fixed”, etc.) can only be seen on the Position screen (see 
page 70).

Preliminary Steps

It is assumed that you have already run all the instructions 
detailed in Chapter 2. Preparing For First-Time Use on page 4.

1. Turn on the receiver by pressing the  red button.
2. Double-tap the Mobile Mapping icon.
3. Press the NAV key until you see the Satellite Status screen 

(see opposite) Wait until at least 4 satellites are received. 
For the best accuracy it is important to hold the receiver at 
an angle of 45° from horizontal and not too close to you.

45°
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Entering a job name

Logging screen

The Logging screen also 
displays the time elapsed 

since you started logging at 
this point feature, the 

number of satellites cur-
rently received and the cur-

rent value of PDOP.
Logging New GPS/GIS Data

1. Creating a Job and Selecting a Feature Library

- Press the LOG button.
- Tap Create New Job.
- Enter the job name and press ENTER
- Tap the “TUTORIAL.MMF” feature library (or as 

required).
- Tap the “Real-Time” job mode (or as required).

2. Logging and Describing a Point Feature

- Highlight the “Str Light” feature (you are supposed to 
be near one of these features) and tap the on-screen 
Log button. This starts feature logging. A sound is 
heard every time ProMark3 logs data.
The Logging screen is now displayed where you can 
see the list of attributes pertaining to this feature. You 
will now enter the “Description” phase of the feature

- Tap the first attribute (“Condition”) and then tap the 
right attribute value describing the feature near you 
(for example “Good”). This takes you back to the Log-
ging screen.

- Select the next attribute in the list and repeat the pre-
vious step. Repeat this step until all the attributes 
have been properly described.
“Describing” the feature only takes a few seconds. By 
the time you are done with the feature description, the 
feature’s GPS position will probably have been saved 
in the job. You can also stay more time on the feature 
to let the receiver determine several positions. This 
will give an even more accurate position for the feature 
as ProMark3 will average all the GPS positions it has 
computed on the feature.
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Selecting the logging inter-
val option

Logging screen

The Logging screen also 
displays the distance trav-
eled since you started log-

ging the line feature.
- To stop logging the feature, tap Done. This takes you 
back to the Feature List screen

- Move to the next feature and resume the above 
instructions to log this feature.

3. Logging and Describing a Line Feature

Basically, you use the same procedure as when you log a 
point feature (see 2. above). There are however two differ-
ences when you log a line feature:
- You need to define a logging interval when you start 

logging the feature
- And then you are supposed to move from the begin-

ning to the end of the line feature before stopping the 
logging.

These differences are explained below.
After tapping the “Road” line feature from the Feature 
List screen and tapping the Log button, ProMark3 starts 
logging GPS positions from the position where you are. 
The default logging interval is 5 seconds. To change this 
interval:
- Tap Options on the screen and highlight Logging Inter-

val. Two options are then prompted:
By Time: Select this option when you want to log a new 
GPS position at regular intervals of time regardless of 
the distance traveled since the last position logged. 
After tapping this option, tap the desired time interval. 
This takes you back to the Logging screen where you 
can see the list of attributes pertaining to the feature.
By Distance: Select this option when you want to log a 
new GPS position only after you have moved by a cer-
tain distance since the last position logged. After tap-
ping this option, tap the desired distance interval. This 
takes you back to the Logging screen where you can 
see the list of attributes pertaining to the feature.
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Logging screen

This screen displays the 
current values of perime-

ter and area measured 
since you started logging 
the feature (+ number of 

satellites and PDOP)
- As you would for a point feature, describe the feature 
by describing the different attributes pertaining to the 
feature.

- When the description is finished, you can start walking 
along the road.

- When you arrive at the end of the road, with ProMark3 
still displaying the Logging screen, tap Done to stop 
logging the feature.

4. Logging and Describing an Area Feature

Basically, you use the same procedure as when you log a 
line feature, especially regarding the need for defining a 
logging interval (see 3. above).
The only difference between a line and area feature is that 
for an area feature, the first and last position calculated 
by the receiver are connected when you close the feature.

Record the attributes of an area feature as you do for a 
line feature (see page 57):
- Tap the name of the “Park” area feature from the list 

of features and tap the Log button. ProMark3 starts 
logging the area feature.

- Choose a logging interval using the Options button (see 
explanations given for a line area on page 57). This 
takes you back to the Logging screen where the list of 
attributes for the feature is displayed

- Describe each attribute by selecting or entering the 
appropriate attribute value for each of them.
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Job List screen 

Screen prompting you to go 
to the selected feature

When you know which 
attributes must be changed 

for a point feature, which 
means you don’t really 
need to visit the point, 

then tap Edit rather than 
Goto and change the 

attributes directly.
Revisiting and Updating Existing GPS/GIS 

Jobs

You can use ProMark3 not only to position and describe new 
GIS features but also to update information gathered previ-
ously. This is particularly useful when collecting data on 
things that change over time: streetlight bulbs burn out, new 
roads are added to housing developments, new crops are 
planted, etc.

1. General Procedure

Return to the area where the original job was recorded, turn 
ProMark3 on and double-tap the Mobile Mapping icon. When it 
has calculated a GPS position, follow the procedure below to 
update the job or to append more data to it.
- Press the LOG button and tap Open Existing Job.
- Tap the name of the job you want to revisit.
- Unless this screen is already displayed, press NAV repeat-

edly until the Map screen is displayed. The Map screen 
provides a geographical view of the different features 
present in the job. From this screen, you will now indicate 
the first feature you want to revisit. If necessary, press the 
IN or OUT button to adjust the scale so you can see this 
feature.

- On the Map screen, tap on the feature you want to revisit 
first. (The feature name appears in the lower part of the 
screen when the cursor is positioned over the feature.)

- When the map cursor is positioned over the feature to be 
updated, press ENTER. A new screen is displayed showing 
the attribute values currently assigned to the feature. Note 
that the Goto field is highlighted at the bottom of the 
screen.
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Map screen showing 

straight line to target 
- Tap Goto to ask ProMark3 to guide you to this feature. By 
doing this, you will make the selected feature your desti-
nation and all the navigation screens will be set to help 
you reach that feature. The Map screen will also be auto-
matically displayed showing a straight line connecting 
your current position to the selected feature.

- Walk to the feature according to the navigation instruc-
tions provided on the Map screen. You can use other navi-
gation screens if you prefer (see also Navigation Screens 
chapter from page 69). You will know when you are close 
to the feature when the distance to the feature goes to 
zero or close to zero, or simply because you can identify it 
visually. Another nice way of being informed that you have 
arrived at the feature is to set the Alarms option (see expla-
nations in the ProMark3 Reference Manual)

- After arriving at the feature, press the LOG key. This takes 
you to the Feature Attributes screen.

- Now that you are near the feature and you can see which 
of its attributes need to be changed, tap successively each 
of these attributes and change them.

- After reviewing the attributes, tap the Done field at the 
bottom of the screen. This ends the review of this feature 
and displays the Map screen again.

- Follow the same steps described above to revisit and 
update the other features present in the job.
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2. Repositioning a Point Feature

If a point feature appears to be mislocated on the Map screen, 
do the following after you have arrived at the feature:
- Press the LOG key and tap the on-screen Log button. Let 

the ProMark3 recompute the point position and then tap 
the Done button to close the feature.
Note that only point features can be repositioned. If you 
wish to reposition a line or area feature, you should record 
a new feature and then delete the old one in MobileMap-
per Office.

3. Adding More Features and Attributes to the Job

If you want to add more features and descriptions to the exist-
ing job, you just have to record them exactly as you record fea-
tures into a new job.

4. Closing the Job

To close a job, from the screen showing the list of attributes, 
tap Done then confirm by tapping Yes.
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Do not forget to double-tap 
the Surveying icon or else 
no communication will be 

possible between ProMark3 
and the PC. 
8. Office Work

Download Procedures

The easiest way to download ProMark3 data to your PC is to 
remove the SD card from the ProMark3 and insert it into your 
PC card reader. This implies the following:
1. All your field data should have been saved on the SD card 

(see setting on page 8).
2. Your PC should be equipped with an SD card reader.

If you do not have a card reader on your PC, then you should 
connect the ProMark3 to your PC via the USB cable provided.
Field data collected with the FAST Survey option can only be 
downloaded via the USB cable.
This chapter more particularly describes the download proce-
dures based on the use of the USB cable provided. It is as-
sumed that both GNSS Solutions and Mobile Mapper Office 
have already been installed on your PC.

Working on Field Data 
Collected With “Surveying”

Downloading Raw Data
1. On ProMark3:

- Turn on the receiver.
- Double-tap the Surveying icon.
- Make sure the ProMark3 Storage option setting will 

allow the Download utility to access the desired files. 
For example, if the files to be downloaded are on the 
SD Card, make sure SD Card is selected as the Storage 
option. To set this information, press the MENU key 
then select Setup then Storage.

2. Clip the I/O module as shown opposite.
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It is very important that you 
connect the ProMark3 to 

the PC BEFORE running 
Download. 

If you have some difficulty 
identifying which port 

number should be 
selected, first run Down-

load WITHOUT the connec-
tion to ProMark3 in order 
to list the available ports. 
Then quit Download and 

resume the operation after 
connecting ProMark3. An 

additional port will then 
appear in the list. This 

additional port is precisely 
the port you need to select 

to allow communication 
with ProMark3.
3. Connect the USB cable between the ProMark3 unit and 
your PC.

The first time you connect ProMark3 to the office PC, 
you may be asked to install a USB driver on the PC 
(although this driver should normally have been installed 
when installing GNSS Solutions). This driver is located on 
the GNSS Solutions CD in the “.../USB Driver/PROMARK/
” folder. Once you have inserted the CD in your CD drive, 
ask the PC to search for this driver on the installation CD 
and then follow the on-screen instructions to complete the 
driver installation.

4. On the PC:
- From the Windows task bar, select Start>Pro-

grams>GNSS Solutions>Tools>Download.

(Double-click  in the right side of the window if 
you want to change to the parent directory and open 
another folder on your PC.)

- In the Download window, select File>Con-
nect>Receiver>Connect via Cable. This opens the Con-
nect Via Cable dialog.

- In this dialog, choose the port created on the PC fol-
lowing the installation of the USB driver and then click 
OK. The following appears successively in the status 
bar, at the bottom of the window:

Looking for remote on COMx at xxxx Baud...
Connected to Data Source
Setting Baud rate...
Preparing for listing...
Directory has been listed

The left side of the Download window then lists the 
files present in the ProMark3.

- Select the files you want to download. If necessary, 
hold down the Ctrl key to make a multiple selection.
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downloading of an observa-
tion file are named as fol-

lows:
X<Downloadedfilename>

where prefix X = “E” for 
Ephemeris Data, “B” for 

Position Data, “D” for GPS 
Raw Data and “W” for 

SBAS Data.
- Press the F5 key. A Copying file dialog appears during 
data transfer.
After the transfer is complete, notice in the right side 
of the Download window that each downloaded file has 
been split into different files named with a prefix as 
explained opposite.

- Close the Download window.
5. On ProMark3, quit the Surveying function, turn off the 

receiver and remove the cable between the PC and 
ProMark3.

6. Repeat the previous 5 steps for each of the ProMark3 
units involved in the project to download their respective 
files to the same project folder on your office computer.

Downloading RTK Data
1. Resume steps 1 to 3 described in Downloading Raw Data 

on page 62.
2. On the PC:

- Run GNSS Solutions and open or create the project in 
which to download your RTK results.

- In GNSS Solutions, select Tools>Preferences and make 
sure Show RTK functions is enabled, otherwise check it 
and then click OK.

- Select Project>Download Positions from External Device.
- Select ProMark3 Surveying and click OK. This launches 

the Download Utility on the PC. The left side of the 
Download window then lists the files present in the 
ProMark3 RTK.

- Select the O-files you want to download
- Press the F5 key to start the file transfer.
- When the transfer is complete, close the Download 

window. The RTK results are now visible in the project 
open in GNSS Solutions.
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Post-Processing Raw Data

1. On your office computer, launch GNSS Solutions
2. Click Create a New Project, enter a project name and then 

click OK.
3. Click Import Raw Data from Files.
4. Browse your computer to change to the folder containing 

the data files you have just downloaded.
5. Select the files you want to import and click Open. The 

Importing GPS Data dialog lists the files you want to import 
(top). Each row describes one of these files (filename, 
associated Site ID, etc.)

6. At the bottom of the window, define which of the sites is 
the control point (base) and enter or check its known coor-
dinates. You can also fix the control point if necessary by 
selecting one of the options available in the Fixed column. 
If you select <Blank>, the point won’t be fixed.

7. Click OK>To Import to import the data into the project. 
Depending on the type of survey, you can go even faster by 
running, in one operation, the Import, Process and Adjust 
functions.
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Downloading RTK Data 
Collected With FAST Survey

1. On the ProMark3 RTK:
- Clip the I/O module as shown opposite.
- Turn on the ProMark3 RTK.
- Connect the USB cable between the ProMark3 unit 

and your PC.

The first time you connect ProMark3 to the office 
PC, you may be asked to install a USB driver on the PC 
(although this driver should normally have been 
installed when installing GNSS Solutions). This driver 
is located on the GNSS Solutions CD in the “.../USB 
Driver/PROMARK/” folder. Once you have inserted the 
CD in your CD drive, ask the PC to search for this 
driver on the installation CD and then follow the on-
screen instructions to complete the driver installation.

- Double-tap the FAST Survey icon.
- Select File>6. Data Transfer. This opens the Data Trans-

fer window.
- At the bottom of this window, select “USB (COMx)” 

from the COM Port combo box.
- Tap the SurvCom Transfer button. This opens the File 

Transfer window.
2. On the PC:

- Launch GNSS Solutions and then click Create a new 
Project.

- Name the project and click OK.
- Select the same coordinate system (spatial reference 

system) as one the used in FAST Survey for the job you 
want to download. Select the appropriate time zone 
and then click OK.

- Click Do Not Import Anything Now. A new empty project 
opens in GNSS Solutions.
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- Select Tools>Preferences and make sure Show RTK 

functions is enabled otherwise check it and then click 
OK.

- From the menu bar, select Project>Download Positions 
from External Device.

- In the dialog that opens, select RTK Results in the left 
pane and then FAST Survey data collector in the right 
pane.

- Click OK. This opens the Data Transfer dialog box.
- Select the PC port connected to the ProMark3 RTK 

(USBx) and then click OK. A new dialog appears listing 
the .crd job files stored in the ProMark3 RTK.

- Click on the job you want to download. The name of 
the selected job appears in the upper field.

- Click OK. The job is then downloaded to the project 
open in GNSS Solutions. On the PC, a job folder is 
created in the open project folder to store all the 
downloaded files. At the end of the transfer, the job 
results can be seen on the project’s Survey view. 

Working on Field Data 
Collected With “Mobile Mapping”

Downloading GIS Data
Follow the same procedure as when you download raw data 
files. See Downloading Raw Data on page 62. The only differ-
ences are:
1. On the ProMark3, run the Mobile Mapping application 

instead of the Surveying application before running the 
office software. On the PC, select Start>Pro-
grams>MobileMapper Office>MobileMapper Transfer from the 
Windows task bar. This runs the Download utility.

2. The files you need to download are those with the MMJ 
extension.
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Exporting Data to a GIS
The most important processing of your field data is its export 
to a GIS. Exporting field data has two processes: conversion 
of the data files to a standard format a GIS can read and then 
the actual transfer of the file.
1. On your office computer, launch MobileMapper Office
2. From the menu bar, select File>Open
3. Select the folder where you downloaded your files. 
4. Select the MMJ file you want to open and then click Open. 

MobileMapper Office now views the data collected in the 
field.

5. From the menu bar, select File>Export.
6. Select one of the formats displayed and you will see a 

“Browse for Folder” window that allows you to select the 
directory to which the reformatted file will be transferred. 
If you don't know where to put this file, just select a tem-
porary location.

7. Click Export. Your job will be automatically formatted and 
transferred to the selected folder. You can select any 
folder that is accessible by your PC - including any GIS 
folders that may be on your network. When you start 
recording real data to export to a GIS, you will typically 
export data to a GIS database.
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Sa

D

Speedometer screen

Navigation 
screens
9. Navigation Tools

Whether you are performing survey or GIS jobs, you can always 
rely on ProMark3’s integrated navigation screens to help you 
find your working area of the day or find more easily some par-
ticular locations you need to go to.

NAV Key

As shown in the diagram below, you simply have to press the 
NAV key repeatedly until the screen displays the navigation 
screen you would like to use as your favorite guidance tool. 
You can also use the ESC key to scroll through the navigation 
screens in reverse order.

Map screen: Shows a map of the area around your current lo-
cation. Use the IN and OUT buttons to adjust the scale.
Compass screen: Displays your heading graphically. The direc-
tion followed is always oriented vertically and upward.

Map screen
Compass screent Status screen

Position screenata screen

Large Data screen

Press NAV

Road screen
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Large Data screen: Displays 4 navigation parameters in digital 
form using big characters to be seen from farther.
Position screen: Shows all of the basic position, time and sat-
ellite information. Additionally, current navigation information 
is shown in the bottom half of the screen.
The Position screen shows the current position solution sta-
tus. When using Mobile Mapping in RTK (ProMark3 RTK 
only), this screen is the only screen that shows whether the 
position solution is fixed or not (see screen opposite).
Road screen: Presents your route as if you were traveling on a 
road. Feature/waypoint and destination icons will be displayed 
relative to your position as they come into view.
Data screen: Displays a high density of information, namely 
six data fields plus an active compass.
Speedometer screen: Displays your speed in a familiar graph-
ical format. There are also four additional data fields plus a 
trip odometer.

Satellite Status screen: The Satellite Status screen is includ-
ed with the navigation screens. It indicates conditions of GPS 
reception: number of tracked satellites, their IDs and posi-
tions in the sky, strength of received signals + battery life in-
dicator.

Turning Off Unused Screens

Because some of the available navigation screens may be use-
less in your application, you may want to turn them off.
To do this, press MENU, highlight the Setup option, press EN-
TER, highlight the Nav Screens option and press ENTER again.
You are then asked to turn off or on each of the available nav-
igation screens. Choose “Off” and press ENTER for all these 
screens that you are not currently using.
Note that the Map screen cannot be turned off.
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10. Appendices

Bluetooth Manager Toolbar Memo

Unlocking RTK and FAST Survey
To change your ProMark3 into a ProMark3 RTK, you need to 
download the specific firmware from the Magellan FTP server 
and purchase an upgrade from Magellan.
Before your order the upgrade, please turn on your ProMark3, 
double-tap the Settings icon and then the Magellan System Info 
icon. At the top of the dialog is the ProMark3 Serial Number.

Icon Function

Terminates the search sequence in progress.

Launches a search sequence (“Searching...” is displayed in the status 
bar) to find all the Bluetooth devices present in the vicinity. New icons 
appear in the window as new devices are detected. “Ready” is dis-
played in the status bar at the end of the sequence.

NOTE:  is only active after  has been tapped.
Allows you to list the content of the parent folder. Valid when using the 
File Transfer service of a remote ProMark3 after you have opened a 
subfolder.
Lists the shortcuts you created for the Bluetooth services found in the 
detected remote devices. Any shortcut can be deleted from the list.
Is initially used to search all the remote Bluetooth devices present in 
the vicinity.
Tapping this button after a search has been performed simply lists the 
Bluetooth devices that were detected during the last search sequence.

Tap  to refresh the list of detected Bluetooth devices.
Provides access to all Bluetooth local services available in the 
ProMark3 unit.
Allows you to view or edit the properties of ProMark3’s Bluetooth 
device: General, Security and Options.

Returns the software version of Bluetooth Manager software.

Minimizes the Bluetooth Manager window (but keeps Bluetooth Man-
ager running).
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Please provide your local Magellan dealer, with this serial 
number when ordering the upgrade. You will receive a product 
key in return.
To activate the RTK engine, double-tap the Utilities icon and 
then the Unlock RTK Option icon. Enter the product key and 
then tap OK. A message will confirm that the option has suc-
cessfully been unlocked.
Use the same procedure to unlock the FAST Survey option. 
From the same serial number, your local Magellan dealer will 
deliver a product key specific to your ProMark3 RTK. To acti-
vate the FAST Survey option, double-tap the Utilities icon and 
then the Unlock FAST Survey Option icon. Enter the product key 
and then tap OK. A message will confirm that the option has 
successfully been unlocked.
To purchase an optional FAST Survey function (Total Station 
or GPS), first run FAST Survey, go to Equip> About Fast Sur-
vey>Change Registration and read the registration code on the 
Product Registration screen. Provide your registration code 
when ordering an optional function. You will receive in return 
a Serial Number and a Change Key specific to your FAST Sur-
vey license. Enter these two codes on the same Product Reg-
istration screen to activate the function.

FAST Survey Function Key re-Allocation
The table below lists the keys affected by FAST Survey and 
how FAST Survey re-uses them.

Because the NAV key is re-allocated, FAST Survey disables ac-
cess to the 8 standard navigation screens.

Key New Function

IN Zooms in on all screens where is displayed

OUT Zooms out on all screens where is displayed

MENU Switches between and

NAV Displays the Monitor Skyplot screen

LOG Equivalent to tapping on the different survey screens.
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Glossary

Base: A reference station operated in static 
mode.
Baseline: A three-dimensional vector con-
necting the base to the rover. The baseline 
length is the vector modulus.
DGPS: Differential GPS. A technique where-
by data from a receiver at a known location is 
used to correct the data from a receiver at an 
unknown location. Differential corrections 
can be applied in real-time or by post-pro-
cessing. Since most of the errors in GPS are 
common to users in a wide area, the DGPS-
corrected solution is significantly more accu-
rate than a normal autonomous solution.
Direct IP: (IP=Internet Protocol) A way of ac-
quiring base data (corrections) from the In-
ternet via GPRS. When setting Direct IP in a 
receiver, you must specify the IP address of 
the corrections provider.
Fixed: Position solution status achieved by a 
receiver operating successfully in RTK mode. 
Position accuracy is in the order of one cen-
timeter.
Float: Intermediate position solution status 
obtained in a receiver attempting to operate 
in RTK mode. Position accuracy is also inter-
mediate as it is only in the order of a few 
decimeters.
GNSS: Global Navigation Satellite System. 
GPS, GLONASS and the future Galileo are 
each a GNSS.
GPRS: General Packet Radio Service. A mo-
bile data service available to cell phone us-
ers. GPRS data transfer is typically charged 
per megabyte of transferred data, while data 
communication via traditional circuit switch-
ing is billed per minute of connection time, 
independent of whether the user has actually 
transferred data or he has been in an idle 
state.
GPS: Global Positioning System. Passive, 
satellite-based navigation system operated by 
the Department of Defense of the USA. Its 
primary mission is to provide passive global 
positioning/navigation for land-, sea-, and air-
based operations.

GSM: Global System for Mobile communica-
tions. The most popular standard for mobile 
phones in the world.
HRMS: Horizontal Root Mean Square. A sta-
tistical measure of the scatter of horizontal 
computed positions about a “best fit” posi-
tion solution. It gives you a good indication of 
how well the unit performs.
Initialization: • A process used at power-on to 
help a GPS receiver more easily determine its 
own location. The solution is of the GPS stan-
dalone type (accuracy is a few meters).
• For an RTK rover, once GPS initialization is 
achieved, a process through which the receiv-
er can solve integer ambiguity from which it 
can deliver a fixed solution with centimeter 
accuracy. 
NTRIP: Networked Transport of RTCM via In-
ternet Protocol. A protocol used by GNSS ser-
vice providers to deliver corrections from 
their networks of reference stations. When 
setting NTRIP in a receiver, you must specify 
the mount point (an IP address) of the NTRIP 
provider as well as your personal user profile. 
PDOP: Position Dilution of Precision. This 
number describes the geometry of the GPS 
constellation. The lower this number, the bet-
ter the geometry of the constellation and the 
better the quality of the position solution.
Rover: The mobile unit that you carry with 
you during your field operations.
RTCM: Radio Technical Commission for Mar-
itime services. RTCM standards are used in-
ternationally for Differential Global 
Navigation Satellite Systems and Electronic 
Chart Systems.
RTK: Real Time Kinematic. An algorithm run 
in a receiver that allows its position to be de-
termined in real time, with centimeter accu-
racy.
UHF: Ultra High Frequency band. Magellan 
radio modems use this frequency band.
VRMS: Vertical Root Mean Square. A statisti-
cal measure of the scatter of vertical comput-
ed positions about a “best fit” position 
solution. It gives you a good indication of how 
well the unit performs.
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